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1. Introduction 

M-Files 2018 introduces Intelligent Metadata Layer and a completely redesigned user interface along with many other new 

features and enhancements designed to increase performance, reliability, productivity, and efficiency. 

This document walks you through the main enhancements, but for a more detailed description of what Intelligent Metadata 

Layer is and what it can offer to you and your organization, see the document M-Files Intelligent Metadata Layer. 

1.1 System Requirements 

Refer to System Requirements in the user guide for comprehensive details on the system requirements. 

1.2 Discontinued Features 

The following features are no longer supported in M-Files 2018: 

• We have ended support for Windows Vista. Microsoft stopped supporting Windows Vista in April 2017. 

• M-Files 2018 does not support embedding the username and password of a user to links shared via M-Files Web. 
Instead, with M-Files 2015.2 and newer, we recommend using the Share Public Link functionality. 

1.3 How to Upgrade 

M-Files customers with an active Upgrades and Support Subscription have the right to update their M-Files software at no 

charge. If you need support for installing or upgrading the software, or if you want to gain as much benefit as possible from 

the features in M-Files 2018 for the specific needs of your company, our consulting services are available. Our customer 

service staff is also available to assist you with any licensing and subscription related matters. 

Please see the detailed upgrade instructions to get started with M-Files 2018. 

Note: The file data encryption mechanism was upgraded for M-Files 2015.3. If you are updating to M-Files 2018 
from the version 2015.2 or older, run the Update Encryption Status of Existing Files command for all the vaults 
that have the Enable encryption for file data at rest feature enabled. 

1.4 Contact Us 

Please contact an M-Files Partner or our sales team for a custom online or on-site presentation of M-Files tailored for your 

business needs. Email us at sales@m-files.com. For technical support, please send your requests to support@m-files.com or 

visit http://support.m-files.com.  

http://www.m-files.com/user-guide/latest/eng/#System_requirements.html
http://www.m-files.com/consulting-services/
http://www.m-files.com/support
http://www.m-files.com/support
http://www.m-files.com/user-guide/latest/eng/#Update_software.html
http://www.m-files.com/user-guide/latest/eng/Maintenance.html
mailto::sales@m-files.com
mailto:support@m-files.com
http://support.m-files.com/
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2. Intelligent Metadata Layer 

M-Files 2018 introduces Intelligent Metadata Layer (IML), which is a repository-neutral approach to enterprise content 

management that unifies information across different sources based on context, not on the system or folder in which the 

information is stored. 

Please refer to the document M-Files Intelligent Metadata Layer for a detailed description of what IML is, how it works, and 

how it can improve the information and document management capabilities of your organization. The document defines the 

high-level architecture of IML and provides instructions on how to take it into use. 

3. New M-Files User Interface 

M-Files 2018 introduces a completely new user interface that makes M-Files even more engaging and personal. The most 

remarkable changes are the more powerful new home screen and the new search experience. 

3.1 Home Screen 

The new home screen collects all the information that you need for effective and effortless daily use: 

• Quick views contain all the information that you have been working on lately, such as recently accessed documents, 
your assignments, and objects that you have checked out. 

• The Pinned tab is the place for your most important objects. You can pin views, objects and external repository 
folders and files so that you are able find important information directly via the home screen. Thanks to IML, it does 
not matter whether the information resides in an M-Files vault or in any of the connected external repositories. 

• The area at the top of the user interface allows you to easily navigate between different areas of the user interface. 
With the tabs on the left side, you can navigate between the most used views, and with the ones on the right, you 
can select between the metadata card, document preview, search filters and the Pinned tab. 

 
Figure 1: M-Files 2018 user interface. 
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3.1.1  Opening the Task Area 

In M-Files 2018, the task area is hidden by default. It can be displayed (or hidden again) by clicking the vertical tab on the 

right edge of the task area.  

 
Figure 2: The user interface with the task area visible. 

Administrators can also define out-of-the-box behavior for the task area. In some cases it may be a good idea to have the 

task area visible by default. Add the following registry key on the client computer to define whether task area is visible or 

hidden by default: 

Key HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files\<version>\Client\MFShell\<vault name> 

 

Value name TaskPaneInitialState 

Value type REG_DWORD 

Description Defines whether the task area is hidden, visible, or completely disabled.  
 
The task area is hidden by default and users can choose to display it via the M-Files client. You can change the 
behavior by using this registry key. 

Default value 1 The task area is hidden. 

Valid values  0 The task area is disabled and cannot be opened by the end user. 

1 The task area is hidden by default but can be expanded by the user. 

2 The task area is visible by default but can be hidden by the user. 
 

3.1.2  Pinning an Object 

The most straightforward way to pin an object is to drag it from a listing area to the Pinned tab. You can also pin an object 

via the metadata card or by right-clicking it in the listing area and selecting Pin in the context menu. You can pin M-Files 

views, objects and external repository folders and files. For example, you can pin the SharePoint folder of your team or a 

document in a network folder that you regularly need. 
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Figure 3: Pinning an object in M-Files 2018. 

You can unpin an object by right-clicking it in the listing area and selecting Unpin from the 

context menu or by right-clicking the pinned object on the Pinned tab and selecting Unpin in the 

context menu. 

 

3.2 Search Experience 

In addition to the search options that can be accessed by clicking the search options icon (  ) on the right side of the search 

field, you can further refine your search via the Filters tab (  ) in the right pane. The Filters tab is also opened whenever 

you activate the quick search field. 

Search results from other vaults can be found at the bottom of the left pane, the same way as in M-Files 2015.3. 

 
Figure 4: M-Files 2018 search. 
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4. Performance Improvements 

4.1 Streaming Support 

M-Files 2018 supports file streaming. This is especially beneficial with, for example, large video files or with very large PDF's. 

With video files, streaming allows the playback application to start playing the video content immediately after the file is 

opened. You can also skip to a particular part of a video. File streaming also facilitates copying large files from M-Files to 

your computer. 

4.2 Office Document Optimization 

M-Files 2015.3 SR2, M-Files 2018, and later optimize the way M-Files properties are read in M-Files Desktop when Microsoft 

Office documents are opened. Depending on the number of properties, documents now open up to 50 percent faster than 

before. 

4.3 Metadata Card Optimization 

In M-Files 2018, we have streamlined how M-Files Desktop opens the metadata card. The metadata card in a vault with a 

complex metadata structure now opens up to 40 percent faster than before. 

4.4 Optimizations Related to User Group Operations 

M-Files 2018 significantly improves performance in environments with tens of thousands of user groups. This includes 

operations performed via M-Files API as well. 

Operations that are remarkably enhanced: 

• Logging in to vaults 

• Viewing the metadata card 

4.5 Metadata Structure Version Unchanged when Users or User Groups Added or Modified 

M-Files 2018 now keeps local cache untouched when users or user groups are added or modified. 

4.6 SQL Server 2016 Service Pack 1 Performance Optimization 

M-Files 2018 Server can utilize the Columnstore Index feature in the Express, Standard, and Enterprise editions of Microsoft 
SQL Server 2016 SP1 and later. This can speed up view queries significantly. This feature was previously supported only with 
SQL Server 2016 Enterprise Edition. 

5. New Configuration Options for External Object Synchronization 

We have added a few very useful configuration options related to the Connections to External Database feature to better 

control how and how often external objects are updated or added from the external database. 

https://blogs.msdn.microsoft.com/sql_server_team/tag/columnstore-index/
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5.1 Forced Full Refresh for External Object Types and Value Lists 

M-Files now allows forced full refresh of external objects and value lists within certain intervals. Previously, the refresh 

operation was only triggered on a daily basis and whenever an M-Files client application requested the value list. Now, with 

the new named value storage settings, you can define the full refresh interval for each external value list and object type 

separately. Refer to Default Refresh Logic and Configuration Options for External Value Lists and Object Types for more 

details. 

This improvement is available in M-Files 2015.3 SR2 and later. 

5.2 Updating Recently Modified External Objects Only 

External objects can be updated either via the Quick Refresh or the Full Refresh operation. The downside of the quick refresh 

operation is that it does not detect changed objects. On the other hand, a full refresh can be a relatively heavy operation 

when synchronizing objects from large external databases. 

You can now apply a registry setting to specify that only new and recently modified data is refreshed when the quick or full 

refresh operation is run. Refer to Default Refresh Logic and Configuration Options for External Value Lists and Object Types 

for more details. 

6. New Configuration Interface for Metadata Card Configuration Rules 

M-Files 2018 has a new configuration interface for metadata card configuration rules. The new interface allows you to edit 

and update rules much easier and faster than before – and also facilitates other usability improvements. 

6.1 Location of the Rules 

The metadata card configuration rules are now a part of the Configurations section of a vault in M-Files Admin: 

      
Figure 5: Opening the metadata card configuration section in M-Files Admin. 
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6.2 Editing the Rules 

Metadata card configuration rules are still made up of the rule name, rule conditions (filters), rule behaviors, and sub-rules.  

You can use the left-side navigation area and the Configuration tab to browse the rule hierarchy. 

 
Figure 6: Metadata card configuration rules in M-Files Admin. 

Selecting a node via the navigation area controls what is displayed in the Configuration tab. This allows you to easily focus on 

small sections of the configuration. 

 
Figure 7: Focusing on a specific part of the metadata card configuration in M-Files Admin. 

For power users and various advanced scenarios, the Advanced tab may be selected to display the underlying JSON 

specification used by the system. This is a slightly different JSON format from the one that was used prior to M-Files 2018. 
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Figure 8: The Advanced tab showing a metadata card configuration rule in JSON. 

6.3 References to the Vault Metadata Structure 

In order to refer to various portions of a vault metadata structure, prior to M-Files 2018, users needed to specify the internal 

ID value of items or the GUID values or the alias of the item. In this new interface, users are able to identify items by simply 

using the current display name of the item. The system will automatically determine the alias, ID or GUID of selected item 

and utilize that value to refer to the element. This saves the user a lot of time and effort, and also increases the readability 

of what the system is doing.   

For instance, to point to an object type, the user may now start typing the name of the object type and then select a suitable 

one in the list of matching values: 

 

Once selected, the system automatically chooses the best available method to refer to that element. You may choose to 

select a different way to refer to that element by clicking the down arrow after selecting the reference: 

   or    
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6.4 Other Features 

6.4.1  Information and Comments 

The new interface also allows additional information and user comments to be displayed. 

When there is information available explaining what various items are for, a blue information icon (     ) is shown next to the 

item name: 

 

You may select any item and then click on the "Comment" tab at the bottom of the screen to enter free-form text that you 

would like to save for providing additional information regarding the selected item. When you have entered a comment, a 

yellow comment indicator is displayed at the right side of the selected item: 

 

6.4.2  Importing and Export Configurations 

To facilitate migration between environments or vaults as well as backing up configurations, you can import and export the 

full set of metadata card configuration rules via the configuration editor. You can access these functions by right-clicking the 

root node in the gray navigation area of the configuration editor: 
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For backing up individual rules or other portions of the configuration, it is recommended to select the desired node and then 

access the Advanced tab. This allows you to copy and paste specific portions of the JSON representation of the rule. 

7. Other New Features and Enhancements 

7.1 Allow or Disallow Properties to Be Used as Search Criteria 

M-Files 2018 allows administrators to determine whether users should or should not be able to use a particular property as 

a search criterion. This can be defined for each property in M-Files Admin, via the Property Definition Properties dialog. 

 
Figure 9: The Property Definition Properties dialog in M-Files Admin. 
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If you choose to disable this option, searches based on the values of the selected property do not generate any results. 

Notice that properties that are not indexed for search will not appear as search condition options in the advanced search 

and view filter features, either. 

Alternatively, you can enable the option and use the Do not search for old object versions suboption to define that users can 

only search for the latest versions of objects on the basis of the values of this property. 

If you think the property is a relevant search criterion, this option should be enabled. Otherwise, it is best to leave it disabled 

to allow the search to perform optimally. 

7.2 New Event Handlers for Creating, Modifying and Deleting Views  

M-Files 2015.3 SR2 and M-Files 2018 can now trigger event handlers when a view is created, deleted or modified. The 

following view-related event handlers have been added: 

• BeforeCreateView and AfterCreateView 

• BeforeModifyView and AfterModifyView 

• BeforeDeleteView and AfterDeleteView 

For a list of all the available event handlers, see Available Event Handlers in the M-Files user guide. 

7.3 Vault-Specific Locale Settings for Server-Side PDF Conversions 

When converting Microsoft Word documents that contain dynamic metadata fields (see Insert M-Files Property) to PDF using 

the server-side PDF conversion feature, M-Files refreshes the metadata fields before the PDF conversion is performed. The 

date values are formatted upon refresh using the locale settings of the M-Files server computer. If you need to change the 

locale of the dates but cannot change the server locale, you can specify a locale for the vault to override the server locale. 

To specify the vault locale, add the following key and value to the named value storage of the target vault: 

• Storage Type: MFConfigurationValue 

• Namespace: M-Files.Core.Server.Settings 

• Key: LocaleName 

• Value: <language culture name>, for instance fi-FI, en-US, or sv-SE 

This improvement is available in M-Files 2015.3 SR2 and later. 

7.4 External File Sources: Extracting Metadata from File Properties 

The Windows properties of files from an external file source can now be used for populating M-Files metadata. These 

properties include, for instance, the creation time, the last accessed time, the file size and the read-only attribute of a file. 

You can take this feature into use via M-Files Admin, under the Connections to External Sources section. Once you have 

opened this section, create a new connection and select the Metadata tab in the properties dialog of the connection. 

On the Metadata tab, select the property that you want to modify, and then click the Edit… button. Then, select the Read 
from the properties of the imported file option, and select a suitable Windows property via the drop-down menu. 

https://m-files.com/user-guide/latest/eng/Event_handlers_variables.html
https://www.m-files.com/user-guide/latest/eng/Insert_M-Files_property.html
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Figure 10: Defining Windows properties for populating M-Files property values. 

The accepted data types for the Windows properties are as follows: 

• Name: Text, Text (multi-line) 

• Directory: Text, Text (multi-line) 

• Extension: Text, Text (multi-line), Choose from list 

o This is the only Windows file property that allows the Add a new item to the list if a matching item is not 
found option to be enabled. The option Use the value read as the name of the item is always selected for 
all the Windows properties. 

• Created at: Timestamp 

• Last modified: Timestamp 

• Last accessed: Timestamp 

• Read-only: Boolean 

• Hidden: Boolean 

• Archive: Boolean 

File properties that are not suitable with the data type of the selected M-Files property cannot be chosen. If you select 

an incompatible file property, the following error message is displayed: "The data type of selected property is not 

suitable for selected Windows file property." 

Note: Only standard Windows file system (FAT32, NTFS) file properties are supported.  
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7.5 Preventing Users from Toggling the Location of the Metadata Card 

You can prevent users from toggling the location of the metadata card between the right pane and the bottom pane by 

hiding the setting from the metadata card option ribbon and disabling it in the View > Display Mode menu. 

Hiding the setting from the metadata card option ribbon 

The metadata card option ribbon is one of the two places where the setting for the metadata card position is displayed. 

 
Figure 11: The setting for toggling the metadata card position in the metadata card option ribbon. 

Option 1: If you have already upgraded to M-Files 2018, you can use the configurations editor in M-Files Admin to create a 

new metadata card configuration rule to hide the toggle setting from the metadata card. The Location Button option can be 

found under Behavior  Metadata Card  Theme. To hide the setting, set the Is Hidden value to Yes. 

 
Figure 12: The option for hiding the metadata card position setting in M-Files 2018. 

Option 2: If you are using M-Files 2015.3, you can use the metadata card rule below to hide the setting. You can leave the 

rule condition empty if you want the rule to be always applied. 

{  
    "MetadataCard": { 
        "Theme": { 
            "LocationButton": { 
                "IsHidden": true 
            } 
        } 
    } 
} 

Disabling the setting in the View menu 

The setting is also located under the Display Mode menu (press Alt in M-Files Desktop and select View > Display Mode). 
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Figure 13: The Show Metadata in Bottom Pane setting in M-Files Desktop. 

If you wish to disable this menu item (as well), you can do so by using a named value configuration. Add the configuration 

shown below using M-Files Named Value Manager. This also moves the metadata card to the right pane the next time users 

log in to the vault. 

https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/0A8D789B-4E2B-4649-B1A1-AF0755B0C444/latest
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Figure 14: Disabling the Show Metadata in Bottom Pane setting via M-Files Named Value Manager. 

This feature is available in M-Files version 11.3.4330.178 and later. The configurations editor is available in M-Files 2018. 

7.6 New M-Files URL Search Parameters 

You can now use new search parameters with M-Files URLs for performing full text searches. Refer to the M-Files URL 

Properties document for a full list of configuration options. 

7.7 Vault Application Approvals 

In M-Files 2018 and later, the default behavior is that approval to run all the vault-specific applications is requested in a 

single prompt. In versions older than M-Files 2018, the approval is requested for each application. If you wish to use the 

app-by-app approval mode in M-Files 2018 and later, you can do so by adding the following registry key to the Windows 

registry of the client computer: 

Key HKEY_LOCAL_MACHINE\Software\Motive\<version>\Client\MFClient 

 

Value name ApproveEachApplicationSeparately 

Value type REG_DWORD 

Description Defines whether vault applications are approved one by one or all at once. 

Default value 1 The setting is enabled, meaning that applications are approved one by one. 

Valid values  0 The approval to run all the vault-specific applications is requested in a single prompt. 

1 The approval is requested for each application. 
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Pre-approving vault applications 

Administrator may wish to pre-approve certain applications, for instance, to avoid user confusion. This can be done by 

distributing a registry key to the client computers: 

Key HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Client\MFClient\ApplicationAccess\ 
<vault GUID> 

 

Value name <the GUID of the application from the application definition file> 

Value type REG_SZ 

Description Identifies a vault application to be pre-approved on behalf of the end user. 

Value <the application checksum from the last line of the application approval dialog> 

7.8 Length Limitation Removed for Inserted M-Files Properties in Microsoft Word 

A limitation preventing more than 255 characters to be inserted into a Microsoft Word document via the M-Files Insert 
Property feature has been removed. M-Files 2018 no longer limits the length of the inserted property, but if required, you 

can take the limitation back to use by adding the following Windows registry setting to the client computer: 

Key HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Client\MFOfficeAddin 

 

Value name LongValueInMultilineTextPropertyInWordAllowed 

Value type REG_DWORD 

Description Defines whether users are allowed to insert long property values (meaning values of over 255 characters) to 
Microsoft Word documents via the M-Files Insert Property feature. 

Default value 1 Inserting long values is allowed. 

Valid values  0 Inserting a long property value to a Microsoft Word document only displays the first 255 characters. 

1 Inserting long values is allowed. The number of inserted characters is not limited to 255 characters. 
 

7.9 Updating the M-Files OCR Module 

The M-Files OCR module, which is used for text recognition (OCR) functionalities in M-Files, has been updated for M-Files 

2018.  

If you wish to use text recognition functionalities in M-Files 2018, or if you are updating from a previous M-Files version to 

M-Files 2018 and want to continue using the M-Files OCR functions, see the document Instructions for enabling the M-Files 

OCR Module for instructions. 

https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/AA4BD59F-EBDD-4D96-B5EF-446A3EA88AC8/latest
https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/AA4BD59F-EBDD-4D96-B5EF-446A3EA88AC8/latest
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8. New Mobile Features 

8.1 Using the Default Browser for OAuth Requests 

iOS and Android applications can be configured to use the default web browser of the device for OAuth requests instead of 

using web pages embedded in the mobile application. This kind of configuration is necessary, for example, when Google is 

used as the identity provider for OAuth authentication. The configuration option has been added because Google no longer 

supports embedded web pages for OAuth requests. You can read more about this change in the Google Developers blog. 

See Configuring OAuth 2.0 for M-Files Authentication for instructions on how to use the default mobile browser for OAuth 

authentication. 

8.2 New User Interface for Mobile Applications 

M-Files Mobile for Android and iOS have new user interfaces. The key changes are: 

• The previous tile-based home screen is no more. The new home screen consists of expandable lists that give you 
quick access to your most important documents.  

• Navigate between the most important views using navigation bar at the bottom of the screen. 

• Search is accessible at all times. 

• The top and bottom panes are hidden when listings are scrolled. 

8.2.1  Pinned Items 

M-Files 2018 introduces the Pinned tab that you can use for storing shortcuts to your most important objects in the vault 

and in any external repository. Read more about the Pinned tab for M-Files Desktop in New M-Files User Interface. 

Pinned items can be accessed via the new home screen in the M-Files Mobile for iOS and Android applications. Pinned items 

are synchronized between the mobile and desktop clients, so you have access to them regardless of the client you are using. 

You can use object context menu (  ) to pin and unpin objects. 

https://developers.googleblog.com/2016/08/modernizing-oauth-interactions-in-native-apps.html
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Note: The new home screen requires M-Files Server 2015.x or later. The Pinned view, however, requires M-Files 
Server 2018. 

8.3 Intelligent Metadata Layer in the Mobile Applications 

M-Files Mobile for iOS and Android support Intelligent Metadata Layer as well. IML for the mobile applications provides the 
following features: 

• Browse external repositories via the M-Files Mobile user interface. 

• Read and edit documents in external repositories via the M-Files Mobile user interface. 

• Search across different repositories (Enterprise Search). 

• Add metadata to files in external repositories.  

• Utilize metadata suggestions when adding metadata to files in external repositories or when adding new content to 
M-Files. 

Figure 15: The new home screen with the Pinned section in iOS. 
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8.4 Support for Reading QR Codes 

The M-Files mobile applications for iOS and Android now support reading QR codes. You can use QR codes, for example, to 

open a particular file, to create a new object, or to execute a search. You can also use QR codes for adding property values 

to the metadata card. Refer to Using QR Codes in M-Files Mobile Applications for more details. 

8.5 Annotating Documents in M-Files Mobile for Android 

Creating and editing document annotations online is now possible with the M-Files mobile application for Android as well. 

The iOS application has already supported this feature for a while. 

Figure 16: Network folder connection and properties of an unmanaged external repository object in iOS. 
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9. New M-Files Web Features 

9.1 Intelligent Metadata Layer in M-Files Web 

M-Files Web also supports Intelligent Metadata Layer. 

IML in M-Files Web allows you to do the following: 

• Browse connected external repositories via the M-Files Web user interface. 

• Read and edit documents located in external repositories via the M-Files user interface. 

• Search for objects across repositories (Enterprise Search). 

• Utilize metadata suggestions for new M-Files objects. 

• Promote external repository objects. 

o This essentially means that a metadata object representing the file in the external repository is created to the 
M-Files vault, allowing you to categorize and locate the object much more easily. 

 

 
Figure 17: Metadata suggestion in M-Files Web. 
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9.2 Office Online Tools for Cloud Customers 

M-Files Cloud Vault users can make use of the viewing and editing capabilities of Office Online in M-Files Web. To use Office 

Online features in your Cloud Vault, enable the Office Online editor option on the M-Files Web configuration page 

(configuration.aspx). 

 
Figure 18: The M-Files Web configuration page. 

9.3 Annotations and Redlining 

Creating and viewing annotations is now supported in M-Files Web as well. To create new annotations, select the Preview 

tab for any document and click New Annotations via the task area on the left. This should open the annotation toolbar in 

the preview window. Once you are done, save your annotations by clicking Save Annotations via the task area. 

The options for hiding, showing and editing annotations are also located in the task area. 
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Figure 19: Annotations in M-Files Web. 

9.4 Improved File Preview 

File preview in M-Files 2018 Web has been improved. You can easily browse through the previewed document by using the 

thumbnail view or by using the improved search function within the Preview tab. 
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Figure 20: The thumbnail view of the Preview tab in M-Files Web. 
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Figure 21: Searching with the word "risk" in the Preview tab in M-Files Web. 

10. Improvements in M-Files APIs 

10.1 Digit Grouping in the M-Files Client API 

M-Files 2015.3 user interface supports digit grouping for formatting real numbers in views and on the metadata card. In 

addition to this, the M-Files Client API now also supports methods for digit grouping. 

The GetValueAsTextEx method now has a parameter called AllowDigitGrouping. If the value of this parameter is 

true, digit grouping is used for integers and real numbers. However, this is effective only if the value of the Localized 

parameter is true as well. 

The GetValueAsLocalizedTextEx method has the same AllowDigitGrouping parameter. If the value of the 

parameter is true, similarly to GetValueAsTextEx, digit grouping is used for integers and real numbers. 
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11. M-Files Language Versions 

M-Files 2018 is available in the following user interface languages: 

 Albanian 

 Arabic 

 Bulgarian 

 Chinese (Traditional/Taiwan) 

 Chinese (Simplified/RPC) 

 Croatian 

 Czech 

 Danish 

 Dutch 

 English 

 Estonian 

 Finnish 

 French 

 German 

 Greek 

 Hebrew 

 Hungarian 

 Italian 

 Japanese 

 Korean 

 Norwegian 

 Polish 

 Portuguese (Brazil) 

 Romanian 

 Russian 

 Serbian 

 Slovakian 

 Slovenian 

 Spanish 

 Swedish 

 Turkish 
 Vietnamese 

In addition to providing these software localizations, M-Files lets you translate the metadata structure of your vaults to any 

language. Users can individually select the software and metadata structure language of their preference. 

The M-Files Web language is determined by each user's browser settings, but it is equally possible for the system 

administrator to override the language selection via the M-Files Web configuration. 

The language of an M-Files mobile app can be changed via the language settings of each device.  
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12. Change History 

The table below describes the essential changes by document version. 

VERSION DATE ESSENTIAL CHANGES 

0.1 2017-09-18 Alpha documentation. 

0.2 2017-11-28 Release Candidate documentation. 

1.0 2017-12-27 Official M-Files 2018 release documentation. 

1.1 2017-12-29 Added chapter 7.7. 

13. Reference Documents 

• M-Files Intelligent Metadata Layer 

• Default Refresh Logic and Configuration Options for External Value Lists and Object Types 

• M-Files URL Properties 

• Configuring OAuth 2.0 for M-Files Authentication 

• M-Files Mobile Apps Feature Comparison 

• Using QR Codes in M-Files Mobile Applications 

https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/E6B44414-E58A-4F59-BA6F-3225D01D1904/latest
https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/3AEC36EE-946C-4B0C-9DE2-8BF82DED3078/latest
https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/BE2AA2E4-8B75-43DF-8E31-C045A31938B0/latest
https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/F6433ADE-2E3F-4885-B5CE-7146CB9F6366/latest
https://kb.cloudvault.m-files.com/openfile.aspx?vault=3ECA226F-7B54-428B-B539-DE443E6134EC&objtype=0&docid=20087&fileid=20196&filever=-1
https://kb.cloudvault.m-files.com/Default.aspx?#3ECA226F-7B54-428B-B539-DE443E6134EC/object/7C514755-7B2F-48A3-BE31-355F738CDF88/latest
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